
 
 

Université Mohamed Khider de Biskra 

Faculté des Sciences et de la Technologie 
Département de Génie Electrique 
 
 
 
 
 
 
 
 
 

Sciences et Technologies 
Electronique 

Electronique des Systèmes embarqués 
 

Réf. : Entrez la référence du document 
 
 

Présenté et soutenu par :  

 Boumaraf Sara 
 

Le : Click here to enter a date. 
 
 

 

Energy Saving Through Home Automation 

 

 
 

Jury : 
 

M. Benakcha Abed El Hamid      Pr Université de Biskra Président 
 

M. Athamna Noura   MAA Université de Biskra Examinateur 
 

M.  Ouarhlent Saloua MAA Université de Biskra Rapporteur 
 
 
 
 
 

Année universitaire : 2019 – 2020 
 
 
 
 

MÉMOIRE DE MASTER 



 

 الجمهورية الجزائرية الديمقراطية الشعبية
Peoples Democratic Republic of Algeria 

 وزارة التعليم العالي و البحث العلمي
Ministry of Higher Education and Scientific Research 

 
University Mohamed Khider Biskra 

Faculty of Science and Technology 
Department of Electrical Engineering. 

Sector: Electronique 

Option: Electronics of Embedded Systems 

 

A Thesis prepared for the requirement of 

 MASTERS Degree 

 

Theme 
Energy Saving Through  

Home Automation 
 
 

Prepared by:                                                                                       Supervisor by: 
Sara Boumaraf                                                                                   Prof. Ouarhlent Saloua                    
  

Favorable opinion of the President of the Jury 
Mr.Benakcha Abed El Hamid 

 

Stamp and signature 

 

 
 
 

 



 

 

 

ABSTRACT 
 

        Reducing energy consumption or rather wasting energy is a way to save energy. Today, 

most of the energy is wasted on fans and lights that are not unplugged when not in use. In order 

to save energy, we can do simple things like turn off the light or the fan when we leave the room.  

       So that’s why we created a home automation model with different operating modes, which 

can also be controlled using an Android app.  

      The proposed model allows users to control their electrical appliances automatically it also 

alerts them if there is a gas leak. As part of this research, we aim to integrate several elements 

like relays, GSM module and some sensors.  

       Finally, the design and realization of this model depend on Arduino, so that it will manage 

all the processes in this system. 

 

KEYWORDS: Arduino, relay, sensors, GSM, electrical appliances, Android app. 

 

 

 ملخص

الطاقة  قت الحالي،تضيعفي الو. لتوفير الطاقة هو وسيلة لأحرى إهدار الطاقةأو با المفرط الطاقة إن تقليل استهلاك          

ام بأشياء بسيطة مثل إيقاف ولتوفير الطاقة،يمكننا القي.بسبب المراوح والأضواء التي لا يتم فصلها عندما لا تكون قيد الاستخدام

 .الضوء أو المروحة عندما نغادر الغرفة تشغيل

 تطبيقفيها باستخدام  التحكم أيضاوالتي يمكن  ،تشغيل مختلفةللتشغيل الآلي للمنزل مع أوضاع نموذجا أنشانا  لذلك          

 .الاندرويد

ا يقوم بتنبيههم في حالة كم اللمستخدمين التحكم في أجهزتهم الكهربائية تلقائي النموذج المقترح في هذا النظام يسمح          

 .شعراتالمست وبعض ,GSM العديد من العناصر مثل المرحلات إلى دمج ، نهدفحثالب إطار هذافي  للغاز. وجود تسرب

 .النظام لمتعلقة بهذاا المعلومات بحيث يقوم بمعالجة جميع لاردينوا أخيرا يعتمد تصميم وتنفيذ هذا النموذج على  و          

 .اندرو يدتطبيق ,أجهزة كهربائية,مرحلات ,GSM,مستشعرات,اردينو:الكلمات المفتاحية

 

 



 

 

 

RESUME 

         Réduire la consommation d'énergie ou plutôt le gaspillage d'énergie est un moyen 

d'économiser de l'énergie. Aujourd'hui, la plus grande partie de l'énergie est gaspillée à cause des 

ventilateurs et des lampes qui ne sont pas débranchés lorsqu'ils ne sont pas en service. Afin 

d'économiser de l'énergie, nous pouvons faire des choses simples comme éteindre la lumière ou 

le ventilateur lorsque nous quittons la pièce. 

          C'est pourquoi nous avons créé un modèle domotique avec différents modes de 

fonctionnement qui peuvent également être contrôlés à l'aide de l'application Androïde. Le 

modèle proposé permet aux utilisateurs de contrôler automatiquement leurs appareils électriques, 

Il pourra aussi avertir le propriétaire au cas où une fuite de gaz se déclencherait. 

          Dans le cadre de cette recherche, nous visons à intégré plusieurs éléments comme des 

relais, Module GSM, et de capteurs.  

          Au final, la conception et la réalisation de ce modèle dépend d’Arduino pour que ce 

dernier va gérer tous les processus dans ce système. 

Mots-clés: Arduino, capteurs, appareils électriques, Relais, GSM, application Androïde. 
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GENERAL INTRODUCTION 
 

2 

 

 

         Electricity availability is actually one of the main challenges that people face in 

daily life. Resources should be used wisely to conserve them for future use because they 

are limited and expire in one day. Therefore, we need to save energy every day to save 

our money and resources as well. 

        To deal the situation a system should be suggested in such a way as to switch the 

electrical appliances off while not in use. Switching off the electrical appliances is 

unpleasant for the user because the switches are placed far away from them. So a system 

is required for the electrical appliances to work automatically. We all need resource 

savings, but the most important thing is to find the best ways to do that. A variety of 

strategies for this management plan have been proposed. 

         In this research, we propose a simple home automation prototype where a user can 

turn on and off the power of an electrical device in the home through an application on a 

mobile phone or by using a relay with the help of sensors and microcontroller. 

         This prototype consisted of an Arduino controller, we are going to describe more 

detail about it in the following lines. 

 

         This thesis is separated into three main chapters:  in the first chapter we will present 

a review about home automation and some it benefits. He second chapter Shows 

descriptions of each of the components that constitute our system. In the third chapter we 

will discuss about all the software that were used to implement the project, this chapter 

will contains also the block diagram, simulation and  finally the obtained result. Then we 

have a conclusion about this process.  



 

 

 

 

 

 

 

 

 

Chapter I 
Overview of home 

automation
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I.1 Introduction 

         With rapid economic growth, living standards are also rising day by day. The modern 

society wants safe, economic, comfortable and convenient life which is ideal for every family. 

         Home automation is a very promising area. Its main benefits range from increased comfort 

and greater safety and security, to a more rational use of energy and other resources, allowing for 

significant savings. It also offers powerful means for helping and supporting the special needs of 

people with disabilities and, in particular, the elderly. This application domain is very important 

and will steadily increase in the future [1]. 

 

I.2 Home automation 

I.2.1 Definition 

         

household activity. It commonly defines a residence that integrates technology and services 

through home networking to improve the quality of living. Home automation is not a new term 

for science society and has been around for a significant time. Home automation include mainly 

centralized control of lighting, temperature, appliances, and other systems, to provide improved 

comfort, convenience, efficiency and security. For disabled and elderly person home automation 

can be the substitute of institutional care  [1]. 

 

 

Home  automation (Figure I.1) is  known  as  the  automation  of  the  home,  housework  or

Figure I.1.Home automation[2].
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I.2.2 Home automation in past 

        Home automation really started in a physical sense with the formation of mechanization 

items, starting with home apparatuses. 

        The capacity to enlighten the room from a solitary switch radically changed the way we 

lived by making it simple and moderately safe to light vast regions for broadened periods around 

evening time. The following awesome progress accompanied the presentation of the home TV in 

the 1950s and the later presentation of the infrared remote control. The two innovations were 

helpful for point-to-control correspondence between gadgets however did not have a two-route 

trade of data. X10 was discharged in the 1970's as a standard convention for wiring houses for 

home automation.                                                                                                                           .    

1901-1920: The invention of home appliances- like refrigerators, washing machine, dishwashers, 

irons, toaster and garments dryers.            

      1966-1967: The invention of ECHO IV and Kitchen Computer- the ECHO IV was the                                                                                                                                                                                                                                                     

first brilliant device. In spite of the fact that it was not industrially sold, the device could register 

shopping records, control the home's temperature, and turn apparatuses on and off. The "Kitchen 

Computer" was made for the current year. The apparatus was equipped for putting away 

formulas, yet didn't offer many models because of poor advertising. The cutting edge came as the 

Internet, which made an overall system of PCs in the 1990s. Before long, remote Internet as Wi-

Fi turned into a typical apparatus in American homes. 

       2000's: The early 2,000's saw a further ascent in brilliant home innovation, including local 

tech, home systems administration, and different devices showing up available. A combination 

of short-range technologies created by Zen-Sys in 2005, this wireless technology creates a mesh 

network at the user’s home and sends signals at the 900 MHz spectrum. The Z-Wave technology 

is capable of connecting a variety of devices to control appliances, door locks and even flood 

monitors [3]. 
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I.2.3 Home Automation in present 

       In recent years the Internet of Things (IOT) have enabled shrewd innovation to end up 

plainly a vital piece of our day by day lives. Everything from refrigerators, to apparatuses, to 

home security can be controlled with smart home innovation. Home devices, when remotely 

observed and controlled through the Internet, are an essential constituent of the Internet of 

Things.  

       The present smart homes are more about security and living greener. Current patterns in 

home mechanization incorporate remote versatile control, computerized lights, robotized indoor 

regulator modification booking machines, portable/email/content warnings, and remote video 

observation Sensors are the eyes and ears of the home system. There are sensors for an extensive 

variety of uses, for example, measuring temperature, dampness, light, fluid, and gas and 

recognizing development or commotion             .                                                                                                                 

The various technologies used in home automation [3] 

 Bluetooth 

 Wi-Fi 

 Zig-Bee 

 Z-Wave 

 X10 
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Table I.1: technologies used in home automation 

 

Bluetooth is a remote standard that has a place with 

the PAN convention family. It works in the 2.4 GHz 

band partitioned into 79 sub channels with 1MHz 

separating, utilizing FHSS. GFSK and additionally 

PSK regulations are utilized, contingent upon the 

Bluetooth variant utilized. Full duplex exchanges are 

acknowledged by means of TDD. 

 

Wi-Fi is probably the most exploited wireless 

technology nowadays. It belongs to the family of 

(W) LAN networks. In distinction to Bluetooth, the 

Wi-Fi range is partitioned into just 13 halfway 

overlaying sub channels (fourteenth accessible in 

Japan just), each involving the band of 22MHz. 

 

The first remote home mechanization innovation,   

Z-Wave set models for remote home 

computerization. Z-Wave broadened the usable 

scope of home mechanization by influencing all 

gadgets to twofold as repeaters. Its expanded system 

unwavering quality additionally empowered business 

applications. 

 

ZigBee is a radio recurrence (RF) correspondences 

standard. The ZigBee organizer is in charge of 

making and keeping up the system. Each electronic 

gadget (i.e. Clothes washer, Television, Lamp and so 

on). 

 

I.2.4 The X10 

       The beginning of modern home automation technology can be argued to be found with the 

introduction of the X10 technology standard. Conceived in 1975 by Pico Electronics, who later 

partnered with Birmingham Sound Reproducers, X10 laid out the framework for allowing 

remote control access of domestic appliances. 
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existing electrical wiring systems by broadcasting messages such as "turn off" and "turn on" via 

radio frequency bursts.                                                                                      

Three years later in 1978, X10 products began to make their way into stores geared towards 

electronics enthusiasts and shortly after, in the '80s, the CP-290 computer interface made its way 

into the market for the Mattel Aquarius computer.                       

      The CP-290 unit allowed computers to communicate with X10 compatible appliances in the 

home. Over the years, support for Windows and Mac has been included, and gave those 

interested in home automation the ability to program their lighting systems, thermostats, and 

garage doors from their home computers. [4] 

 

 

                            
 

                                    

 

 

 

 

 

 

 

 

 

 

 

The X10(Figure I.2)standardwas designed to allow transmitters and receivers to work over

Figure I.2.The X10 Logo[5].
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I.3 Description of home automation system        

           In 21st century we are living in where automation is playing an important role in human 

Air Conditioner etc. it’s not only refers to minimizing physical efforts but also helps in energy 

efficiency and is less time consuming. The primary motive of home automation is to domestic 

devices by using various techniques like android apps, web pages, global system for mobile 

communication (GSM) [6]. 

        The system helps older ones by controlling home devices with the help of their mobile 

phones as they do not need to move physically for turning the appliances OFF. Important motive 

of home automation system is to “SAVE ELECTRICITY”. With the help of this technology 

anyone can automatically control the home equipment or office equipment. The system is 

absolutely secure, easy to handle, reliable, flexible and kindly affordable. Various techniques 

have been implemented in order to implement home automation system and save energy. Home 

Automation system based on Arduino enwraps that whenever a person will enter the house then 

number of the persons will get increased, bulb will start glowing. The number of persons 

available in the room will be displayed on the LCD Screen. Whenever the room gets empty then 

the bulb will automatically stop glowing making the system power efficient. Home Automation 

system based  also on global system for mobile communication (GSM) and Android application 

enwraps that while there is any danger happens in the house then a SMS will be sent to house 

owner’s mobile phone indicating the existence of a danger in the house and the house owner can 

take some preventive action to protect his house. In most situations the person can operate the 

home appliances with help of an android app present in the mobile phone which will reduce the 

human efforts. The list of different home devices along with switching buttons will be provided 

in an android application. By just touching a particular button enables person to control 

switching of the home appliances using an Android application [6]. 

-life. Home automation system (Figure I.3) helps us to control devices such as light, door, fan,
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Figure I.3. Home automation system [7] 

 

I.4 Benefits of a Home Automation 

         There are many benefits of using home automation systems (Figure II.4). If you forgot to 

turn off your lights or any device when you are out, you can switch them off remotely. You can 

also check your appliances' status remotely and determine whether to turn it on or off, without 

concern where you are located. You can control a device or light, a smart device or a centralized 

control. [8] 

 Convenience 

      Convenience is one of the most important reasons why homeowners like to install home 

automation systems. You can easily control all the electrical devices and lighting in your home 

from one place. Besides, there is no need for you to rely on your neighbors to check whether the 

appliances or lights in your home are on or off when you are away. 

 

 Energy Saving 

      Besides convenience, home automation devices also help you save energy. You can always 

keep up to date with the current status of the appliances and lighting and ensure that nothing is 

ON when they shouldn't be. In fact, some systems can even provide you help with optimal 

schedules to help achieve high energy efficiency. 
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      When the lights and electrical appliances work only when you need them, you will be able to 

save more energy. This can translate into savings in the long term. At the same time, if you 

forgot to switch off a light, air conditioner or any other appliance, there will be no need to return 

back to switch it off. This will save you both time and money. 

 Security 

     When you use home automation systems, you can enhance the level of security in your home. 

Whether you are at your home or away, you can always control the lights. You can even 

automate the lights or appliances to turn on when you are not at home. So, whether you are at 

work or vacation, you can the lights switch on to ward-off potential intruders. It can make it 

appear that someone is home. Similarly, you can also have lights turn on automatically when you 

enter a room or pathway [8]. 

 

 

 

 

 

Figure I.4. Benefits of Home Automation
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I.5 Conclusion 

       In this chapter we’ve seen a review about home automation and its benefits. 

       Recently people have tried to control everything automatically without any physical effort to 

preserve their own energy and power both in their bodies and homes. 

      In general, home automation involves centralized lighting control, temperature control, 

appliances and other systems for greater comfort, convenience, efficiency and security. 
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II.1 Introduction 

This chapter consists of the Arduino board and various materials that have been 

implemented on the home automation system. 

II.2 The Arduino Board 

      The Arduino was originally developed by teachers to make it possible for their design 

students who were not engineers to create interactive objects and environments. Since the 

original Arduino was released in 2005, it is estimated that over 1 million have been sold. 

Designers, educators, engineers, hobbyists, and students have 

Built all kinds of projects that sense and respond to the world with Arduino. [9] 

      Arduino is an open-source design for a microcontroller interface board (use an AVR 

ATMega microcontroller), with a USB plug to connect to your computer and a number of 

connection sockets that can be wired up to external electronics, such as motors, relays, 

light sensors, laser diodes, loudspeakers, microphones, etc.  

They can either be powered through the USB connection from the computer or from a 9V 

battery. They can be controlled from the computer or programmed by the computer and 

then disconnected and allowed to work independently. [10]  

     There are many versions of the Arduino (Figure II.1), and each is designed for a 

specific function. Currently, there are more than 20 versions of Arduino module; we cite a 

few to clarify the evaluation of the scientific and academic product: 

The Arduino Nano, a small program card using USB port this version using an 

ATmega168 microcontroller (Atmega328 for a newer version). 

The Arduino UNO uses ATmega328 microcontroller [11]. 

The Arduino Mega2560, The Mega 2560 employs an ATMega 2560 as the main MCU, 

which has 54 general I/Os to enable you to interface with many more devices. 

The Mega also has more (ADC) channels, and has four hardware serial interfaces 

(unlike the one serial interface found on the Uno). 

The Leonardo uses the 32U4 as the main microcontroller, which has a USB interface built 

in. 

II.2.1Definition

II.2.2The different Arduino boards
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The Lily Pad is unique because it is designed to be sewn into clothing.  

Using conductive thread, you can wire it up to sewable sensors, LEDs, and more.  

The Due uses a 32-bit offers higher-precision ADCs, selectable resolution pulse width 

modulation (PWM), Digital-to-Analog Converters (DACs), a USB host connector, and an 

84 MHz clock speed. [12] 

 

Figure II.1.The different Arduino boards [13]. 
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The board that we are going to use during this thesis is the Arduino Uno, it is shown by 

the following figure:  

 

 The Arduino Uno R3 contains different parts, every part has a specific function and the 

ATmega328P is the main part of it. 

II.2.2.1  The ATmega328 Microcontroller   

     An ATMega328 microcontroller (Figure II.3) is an integrated circuit that resembles the 

elements of a computer, it is the brain that will process the data and information from the 

sensors (inputs), and this with a very reduced processing time, then gives the desired 

instructions on exit. Today, by soldering a large number of bulky components, such as 

transistors; resistors and capacitors everything can be housed in a small black plastic box 

with a number of pins which can be programmed in C language. [15] 

 

Figure II.3. The atmega328 microcontroller [16] 

 

Figure II.2.Arduino Uno Board[14]



Chapter II: Description of the Hardware 

 Page 17 
 

Features [15] 

Table II.1: Features of the atmega328 microcontroller 

Microcontroller  ATmega328 

Clock frequency 

 

16 MHZ 

Operating voltage 

 

5 V 

Input voltage (recommended) 

 

7-12 V 

Input voltage (limit) 

 

6-20 V 

Digital ports 

 

14 I / O (6 PWM outputs) 

Analog ports 

 

6 analog inputs. 

Max current per pin 3.3 V. 50 mA 

Max current per pin 5 V. 500mA 

Memory. 32 Ko Flash 

2 Ko SRAM 

1 Ko EEPROM 

Dimensions 6.86 cm*5.3cm 
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II.2.2.2  Arduino other parts. 

 Reset Button 

Much like turning your computer off and on again, some problems 

with the Arduino can be solved by pushing the reset button. This 

button will restart the code currently uploaded on your Arduino. 

 USB Port 

The USB port takes a standard A-to-B USB cable, often seen on printers or other 

computer peripherals. The USB port serves two purposes: 

 First, it is the cable connection to a computer that allows you to program the board. 

Second, the USB cord will provide power for the Arduino if you’re not using the power 

port [2] so the Arduino is powered through a DC input or a USB connection.  

 Voltage Regulator 

The voltage regulator converts power plugged into the power port 

into the 5 volts and 1 amp standard used by the Arduino 

 Power Port 

The power port includes a barrel-style connector that connects to 

power straight from a wall source (often called a wall-wart) or from 

a battery. This power is used instead of the USB cable. The Arduino 

can take a wide range of voltages (5V–0V DC) but will be damaged 

if power higher than that is connected. 

 Built-In LEDs 

The LEDS marked TX and RX show whether your Arduino is sending 

or receiving data. The one marked L is connected to Pin 13. 

 

 ON Indicator LED 

This LED indicates that the Arduino is getting power when you turn it on. 

 

 Digital I/O Pins 

The holes on this side of the board are called the digital input/output 
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Pins (Pins 2 to 13) they are used to either sense the outside world (input) or Control lights, 

sounds, or motors (output). 

 

 TX/RX Pins 

Pin 0 and Pin 1 are special pins labeled TX and RX. But it is good practice to leave these 

pins empty. Any changes you make to your program won’t load if something is 

Plugged into Pin 0. 

 

 Power and Ground Pins 

Pins related to power are located here. You can use these pins to run power from your 

Arduino to your breadboard circuit. 

 

 Analog Pins 

(A0 to A5)These pins take sensor readings in a range of values (analog), rather 

Than just sending whether something is just on or off (digital). [1] 
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Figure II.4. Different parts of an Arduino [17] 

 

           Like all electronic board which, their constructions are based on a microcontroller 

must be provided with a programming interface as is the case of our Arduino Uno board. 

On a computer, the Arduino board's programming software serves as a code editor 

(language close to C), with functions and libraries specific to ARDUINO (input / output 

management). Once the program has been typed or modified using the keyboard, it will be 

transferred and stored in the card through the USB link. The USB cable supplies both 

power to the card and also carries information. [18] 
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II.3 Arduino IDE Software  

          Arduino IDE is programming environment that allows the user to draft different 

kind of programs and load them into the Arduino microcontroller.  

          Arduino uses user-friendly programming language, which is based on programming 

language called Processing. After the user has written his code, IDE compiles and 

translates the code to the assembler language. After translating the code, the IDE uploads 

the pro-gram to the Arduino microcontroller. Arduino IDE has a built-in code parser that 

will check the user written code before sending it to the Arduino. IDE software includes 

the set of different kind of programs that are ready to be tested on the device. After testing 

the program it can be uploaded to the Arduino by USB cable that vary in different models   

. [19]         

          The Arduino IDE program files are stored in C: ➤ Program Files (x86) ➤ 

Arduino, which includes example sketches located in C: ➤ Program Files (x86) ➤ 

Arduino ➤ examples.                                                                                                                       

Each example sketch is accompanied by a text file outlining the objective of the sketch, 

the breadboard layout of the components, and a circuit diagram.          

            The Arduino IDE is used to write, compile, and upload files to the 

microcontroller.  

A file containing Arduino code is called a sketch.                                                           

Within the Arduino IDE, clicking one of the five IDE symbols Provides quick access   
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 To compile a sketch 

 To compile and upload a sketch  

  To open a blank sketch 

 To open an existing sketch from a list of all sketches,  

 And to save the current sketch.       

 

                                                  Figure II.5. Arduino IDE sketch  

 

     The Open an existing sketch option does not scroll the complete list of sketches, so use 

File ➤ Sketchbook instead. Some useful options from the drop-down menu are given in 

Table II.2. [53] 
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Table II.2: Drop-down Menu Options of the Arduino IDE 

Options 
 

Description 

File ➤ Open Recent A list of recently accessed sketches 

File ➤ Examples Arduino IDE built-in sketches 

Edit ➤ Find Find and replace text in a sketch 

Sketch ➤ Include Library Arduino and contributed libraries 

Tools ➤ Serial Monitor Displays serial data to serial monitor 

Tools ➤ Serial Plotter  Graphic display of serial data 

Tools ➤ Board  Description of the microcontroller 

for example Arduino/Genuino Uno 

Tools ➤ Port  Detail of serial port, 

for example COM3 Arduino/Genuino 

Uno 

File ➤ Open Recent List of recently accessed sketches 

 

II.4 Arduino IDE Sketch 

         An Arduino IDE sketch consists of three parts: variable definition, the void setup (), 

and the void loop () functions. 

         The first part includes defining which Arduino pins are connected to sensors, LEDs, 

or devices, and declaring the values of variables. For example, 

 The int LED pin = 9 instructions defines a variable, named LED pin, with the integer 

value of 9. 

        The void setup () function implements definitions in the first part of the sketch and 

only runs once. For example, the pinMode(LED pin, OUTPUT) instruction defines the 

Arduino pin 9 as an output pin, rather than an input pin by default, since LED pin has the 

value 9. 

         The void loop () function runs continuously and implements the sketch instructions. 

For example, a sketch may turn on and off an LED at given times. Declaring variables in  
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the first part of the sketch makes it easier to update the variable once at the start of the 

sketch, rather than having to check through the sketch and update variables throughout the 

sketch. Comments are prefaced by //, such as // Set LED to pin 9, and are not 

implemented by the microcontroller. With a couple of exceptions, all instruction lines end 

with a semicolon. [53] 

 

II.4.1 Run the Blink Sketch 

1. Connect the Arduino to a computer or laptop with the USB-to-serial cable. 

2. In Arduino IDE, select File ➤ Examples ➤ 01. Basics ➤ Blink. 

3. Click the Compile and Upload, button. 

The  error message indicates that the serial 

Port should be updated. Select Tools ➤ Port and choose the appropriate 

Port (for example, COM3 or COM4) for the Arduino. Go to step 3. 

The error message  indicates 

That the description of the microcontroller should be updated. Select 

Tools ➤ Board and choose the relevant board (for example, Arduino/Genuino Uno). Go 

to step 3. [53] 
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II.5 Features of the Arduino UNO Board 

 Arduino is a USB interface like a serial device. The board directly plug in to the 

computer so it is easy and comfortable to interface with the computer. 

 It is an open source device and very easy to debug the problem so it is more 

advantages between the large Community peoples. In order fast up for application 

it has 16 MHz clock. 

 It has inbuilt in voltage regulation in order to manage power inside and can be 

directly powered by USB without any external power. 

 This board has 13 digital and 6 analog pins to connect the hardware with the 

external environment.  

 With the help of these pins we can directly plug in the real-world data. 

 An onboard LED and reset button is attached in order to make debug process easy. 

[20] 

II.6 Sensors  

     The purpose of a sensor is to respond an input physical property and to convert it into 

an electrical signal that is compatible with electronic circuits. Sensors are electronic 

devices that measure a physical quality such as light or temperature and convert it to a 

voltage 

      There are two types of sensors: digital and analog. Digital sensor output varies 

between one and zero, which translates to sensors voltage range. Analog sensor can 

output any value between its voltage ranges. Its voltage output changes according to the 

reading from the sensor. Digital sensor output is ON (1) often 5v, or OFF (0), 0v. Analog 

sensor is used to measure precise numerical information like temperature or speed. 

Analog sensors can output almost an infinite range of values.                  

 Sensors are used to expand the capabilities of the Arduino. Sensor output is connected to 

input pin of Arduino and the data is converted to digital form. Some sensors have analog 

to digital converter embedded to the sensor so the data is outputted as digital data.                                                                                                                                   

Those sensors which don’t have onboard analog to digital converter, data is sent analog to 

Arduino which then uses its onboard converter to convert data to digital. After data is 

processed to digital form, it can be processed on the microcontroller. [19] 
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II.7 Sensors used 

II.7.1 Temperature Sensor (LM35) 

        Temperature sensor is a device which is used to measure the Temperature.          

LM35 is a precision IC temperature sensor with its output proportional to the temperature  

(in °C). 

With LM35, the temperature can be measured more accurately than with a thermostat. It 

also possesses low self-heating and does not cause more than 0.1 °C temperature rise in 

still air. The operating temperature range is from-55°C to 150°C.The LM35’s low output 

impedance, linear output, and precise inherent calibration make interfacing to readout or 

control circuitry especially easy The LM35 temperature sensor is an analog temperature 

sensor manufactured by Texas Instruments. It is extremely popular in electronics because 

it is precise, inexpensive, very easy to use and extremely reliable. It is able to measure 

temperatures ranging from -55 ° C to + 150 ° C in its most precise version and with the 

right mounting, enough to measure any temperature.[21] 

 

Figure II.4.LM35 sensor [22] 

 Features 

 Low cost  

 more memory, processing and communication capabilities 

 Low output impedance and linear output, precise inherent calibration make 

interfacing to readout or control circuitry especially easy. 

 It can be used with single power supplies, or with plus and minus supplies. As it 

draws only 60μ A from its supply, it has very low self- heating, less than 0.10 in 

still air. [23] 
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II.7.2 Detected gas (MQ-2) 

       Gas sensor is a device which is capable to detect trace amount of gas or any other 

specific type of gaseous emission in a particular area. A gas detector can employ a variety 

of means to realize the presence of gas in particular surrounding. Gas sensor can be used 

to detect combustible, flammable, toxic, and nontoxic gases.  

These types of sensors are generally used in industry, oil rigs, to monitor manufacturing 

process, emerging technology, firefighting, etc.                               

Some of the common gases detected by gas sensors are ammonia,VOCs, CO, CO2, H2S, 

aerosol, hydrogen, oxygen, NOx, etc. [24]   

       MQ-2 module is useful for gas leakage detection in home and industry. It can detect 

H2, LPG, CH4, CO, Alcohol, Smoke, and Propane. Based on its fast response time 

measurements can be taken as soon as possible. Also the sensitivity can be adjusted by the 

potentiometer. When the target combustible gas exist, the sensor’s conductivity is higher 

along with the gas concentration rising.[25] 

 

Figure II.5.MQ-2 gas detector [25] 

 FEATURES        

 Power supply: 5 V 

 gas sensor (LPG) easy to use 

 Can be used in gas leak detection equipment in consumer and industrial 

applications 

 Interface type: analog 

 High sensitivity  

 Quick response 

 Stable and durable 

 Simple driving circuit. [26] 
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       Motion sensors are used in a motion detector which is a device that contains a 

integrated with or connected to other devices that alert the user of the presence of a 

moving object within the field of view. [27]   

       The PIR sensor detects and measure the approaching IR radiations radiated from the 

human body and different objects present in the ambience of its view. Human Beings 

generally emit thermal energy with wavelength around 9-10 micro-meter every day.                                                                                                                          

This sensor is designed to detect these wavelengths and operate accordingly.[28] 

 

Figure II.6. PIR sensor [29] 

 

 Low cost 

 Low power consumption  

 Minimal maintenance 

 

II.8 Relay 

 

        A relay consists of coil and it acts as a electromechanical switch. The magnetic field 

is induced in the circuit and causes the switch to close or open the electrical connection 

when small current flows through the circuit. The relay can control the High voltage 

circuit using small DC voltage circuit without any direct electrical connection (i.e.) the 

high and the low voltage circuit are magnetically separated and electrically separated.              

physical   mechanism  or  electronic  sensor  that  quantifies   motion  that  can  be  either

II.7.3 Motion Sensor (PIR)

Features of PIR Sensor
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. 

Figure II.7. Relay [30] 

 

 Functionality 

         A relay will switch one or more poles, each of whose contacts can be thrown by 

energizing the coil in one of three ways.  

Normally-open (NO) contacts connect the circuit when the relay is activated; the circuit is 

disconnected when the relay is inactive. It is also called a Form A contact or "make" 

contact. NO contacts can also be distinguished as "early-make" or NOEM, which means 

that the contacts will close before the button or switch is fully engaged.  

Normally-closed (NC) contacts disconnect the circuit when the relay is activated. 

 The circuit is connected when the relay is inactive. It is also called a Form B contact or 

"break" contact. NC contacts can also be distinguished as "late-break" or NCLB, which 

means that the contacts will stay, closed until the button or switch is fully disengaged. 

 Change-over (CO), or double-throw (DT), contacts control two circuits: one normally-

open contact and one normally-closed contact with a common terminal. It is also called a 

Form C contact or "transfer" contact ("break before make"). If this type of contact utilizes 

“make before break" functionality, then it is called a Form D contact.  

SPDT – Single Pole Double Throw. A common terminal connects to either of two others. 

Including two for the coil, such a relay has five terminals in total. 

 [17] 
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Figure II.8. Relay Circuits Operation [32] 

 

II.9 GSM MODULE 

GSM (Global System for Mobile communications) is the technology that underpins most 

of the world's mobile phone networks. GSM is an open, digital cellular technology used 

for transmitting mobile voice and data services. GSM operates in the 900MHz and 

1.8GHz bands GSM supports data transfer speeds of up to 9.6 kbps, allowing the 

transmission of basic data services such as SMS. The GSM standard is intended to 

address these problems. In the current work, SIM900 GSM module is used, it is shown in 

Figure II.8 

. 

Figure II.9. GSM MODULE [33]  

II.9.1 Advantages 

1. Maximum range using GSM technology 

2. User friendly 

3. Easy to handle all people 

4. Low cost 
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5. Power saving 

II.9.2 Disadvantages 

1. If GSM network fails system doesn’t work. 

II.9.3 Application 

1. Home automation. 

2. Industrial automation. 

3. Lab automation.[34] 

II.10 Light Detecting Resistors (LDR)  
           Light Dependent Resistor (LDR) is just another special type of resistor and 

therefore has no polarity. This means they can be connected in any direction           

LDR will change its resistance depending on the light around it. It is when the resistor is 

placed in a dark room that it will have a resistance of a few mega ohms and as we 

gradually impose light above the sensor its resistance will start to decrease from mega 

ohms to a few ohms. This property helps the LDR to be used as a light sensor. It can 

detect the amount of light falling on it and thus predict light and dark.  

 

Figure II.10. Light Detecting Resistors (LDR) [35] 

 The benefits of photoresistor 

1. Low cost. 

2. Wide spectral ranges. 

3. Ease of implementation. 

4. Static transfer ratio. 

5. High sensitivity. [36] 
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II.11 BUZZER 

        A horn is an electromechanical or electronic component that produces a sound when 

voltage is applied. Some require direct voltage (electromechanical buzzers), others require 

alternating voltage (piezoelectric transducers) [36] 

 

 

Figure II.11.Buzzer [37] 

 

 

Type: Passive buzzer 

Working voltage: 3.5-5.5v 

Working current: <25mA 

 

 

         The buzzer has two small fixing brackets. The sound power of such a 

component is in the order of 85 dB / cm. It requires a DC voltage to operate, the 

latter should generally be between 3 V and 28 V, depending on the model. A 

buzzer designed to operate at 6 V, generally works very well for any supply 

voltage between 4 V and 8 V, and a buzzer designed to operate at 12 V, can work 

perfectly at a voltage between 6 V and 28 V. [36] 

 

 

Description

Functionality
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II.12 Liquid crystal displays (LCD) 

        Liquid crystal displays, otherwise known as LCD (Liquid Crystal Display) displays, 

are intelligent compact modules and require few external components for proper 

operation. They consume relatively little (from 1 to 5 mA), are used with great ease. 

        They are widely used in microcontroller fixtures. They can also be used during the 

development phase of a program, because you can easily display the values of different 

variables.[38] 

 

Figure II.12. Liquid crystal displays 16*4 [39] 

 

II.13 Fan 

In this module we are using a 12 volt cooling fan for which a adapter is used for power 

supply. [40] 

 

Figure II.13.Fan [41] 
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II.14 Conclusion  

      In this chapter we have approached the electronic part of our project, by making the 

details of each of the components which constitutes our system. we discussed about 

Arduino Uno which is the main element in this project then the sensors, and other 

elements like fan, lcd, relay etc.    

 



 

 

 

 

 

Chapter III 

Software conception and 

Simulation
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III.1 Introduction 

       After having described the material part and the operation of each part of it, we will 

pass to the most important part of our thesis which is the realization of the system. Our 

realizations consist of two main parts:  

o Software part. 

o Simulation part. 

     But first of all we will be presenting the designed system, through the explanation of 

the block diagram, and the representation of the software used to achieve it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter III: Software conception and Simulation 

 Page 37 
 

 

 

 

 

 

 

 

 

 

   

 

                                       Android app (Blynk)                     

Figure III.1. A diagram representing the circuit developed. 

Order  
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GSM network communication  

Lm35 SENSOR PIR SENSOR Q-2 SENSOR 

ARDUINO 

POWER 

SUPPLY (AC) 

FAN 

BULB 

 

LCD 

GSM 

MODULE 

III.2 Block diagram
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III.3 Description of the system 

   The project focuses on this particular aspect of an Arduino Uno and various sensors we 

have:  

 PIR Sensor it is for detecting the presence of a human being. 

  MQ-2 Sensor for detecting the presence of gas 

  LM35 to measure the temperature 

 To achieve energy savings in a typical home without human intervention. An Arduino 

forms the basis of the home automation system , the system will automatically switch the 

appliances ON/ OFF based on the measured data received from the sensors [42] 

 GSM module for sending SMS when there is any gas leak  

 LCD to display the data like temperature, the warning message etc… 

 Android app used to achieve the switching off and on of the electronic device. 

 

III.4 Software used 

      To achieve this project we have used a good deal of software like Proteus Tinkercad, 

virtual serial ports emulator, Blynk and Arduino IDE. 

III.4.1 

      The Proteus Design Suite is a proprietary software tool suite used primarily for 

electronic design automation.  

      The software is used mainly by electronic design engineers and technicians to create 

schematics and electronic prints for manufacturing printed circuit boards.          

It was developed in Yorkshire, England by Labcenter Electronics Ltd. [43] 

 Proteus ISIS: is used by Engineering students & professionals to create 

schematics & simulations of different electronic circuits. 

 Proteus ARES: is used for designing PCB Layouts of electronic circuits. .[44] 

 

Proteus

https://en.wikipedia.org/wiki/Electronic_design_automation
https://en.wikipedia.org/wiki/Design_engineer
https://en.wikipedia.org/wiki/Schematic
https://en.wikipedia.org/wiki/Printed_circuit_board
https://en.wikipedia.org/wiki/Yorkshire
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Figure III.2.Proteus software Version 8.9 

III.4.1.1 

 

Figure III.3. Proteus software 

Section 1: is a toolbar which has simple functionalities like zooming changing copy and 

move options and few other tools. 

Section 2: has two buttons. P is used to open the components list and L is used for editing 

purposes, like you want to edit the properties of any component then simply click on that 

component and then click on L and it will open the properties of that component and you 

can easily edit it. 

Section 3: has different tools, used for designing circuits. 

Description of the Proteus software
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Section 4 is the remote control section of Proteus, as it contains four buttons i.e. Play, 

Step, Pause & Stop. In order to run the simulation, we have to click on this play button. . 

[44] 

 Proteus has many advantages like: 

 Pack containing software that is easy and quick to understand and use. 

 The virtual prototype creation tool helps reduce hardware and software costs when 

designing a project. 

 The technical support is efficient.[45] 

 

III.4.2 

       Android is a complete platform for mobile devices (phone, PDA, notebook, tablets, 

etc.). The Android platform is an OS (Operating System) based on a Linux kernel, under 

an open source license. It is composed of an operating system, libraries (middleware), and 

a set of applications: an email client, a browser, a calendar, etc. 

The services offered by Android facilitate in particular the operation of GSM, Bluetooth, 

WIFI and UMTS telecommunications networks, the manipulation of media, in particular 

video, audio and JPEG images as well as other formats, sensors such as motion sensors, 

camera, compass and GPS receiver, touch screen operation, database storage, viewing 

web pages, multitasking applications and sending messages .[46] 

 

 

Figure III.4. Android logo. 

 

 

 

Android
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    To build an android application we used Blynk.                                                 

 Blynk is an IoT (Internet of Things) platform using which you can easily and remotely 

control hardware.                                                                           

  Additionally, you can also view sensor data, store the data; visualize the data etc. all over 

the internet.                                                                                                           

The Blynk platform supports a wide range of boards and MCUs like:    

  Arduino UNO, Arduino Nano, Mini, Mega, etc. Basically all Arduino boards.          

There are three major components in the Blynk Platform. They are: 

 Blynk App 

 Blynk Server 

 Blynk Libraries 

The Blynk App, which is available for both Android and iOS, allows the user to create 

intuitive interfaces for their projects. The Blynk Server is responsible for the 

communication between your hardware like Arduino and your application on the 

Smartphone. 

Finally, the Blynk Libraries allows the hardware to communicate with the server and 

process all the incoming and outgoing commands. 

First, your hardware is made ready with the help of the necessary libraries. When a 

command is given through the Blynk App on your Smartphone, like Toggle an LED, it 

reaches the Blynk Server and gets redirected to your hardware and based on the command 

received from the server, the hardware responds accordingly. 

To control Arduino using Blynk There are different ways to use:  

 Ethernet 

 Bluetooth 

 Wi-Fi 

 GSM / 3G / LTE  

 USB 

So first of all we have to install the Blynk App on your Smartphone. You might have to 

register with a valid e-mail ID to completely utilize the Blynk services. 
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1. Install the Blynk app from App Store or Google Play Store depending on your 

device. Open the app and enter your credentials, if required. Then select “New 

Project”. Provide an appropriate name to your project and also select the hardware 

i.e. Arduino UNO in my case. 

 

Figure III.5.Blynk app, create a project and choosing the board. 

2. Select the type of connection you are going to use. So, select “WI-FI”. Then click 

on “Create” option. Your Blynk project will be created and an Authentication 

Token will be sent to the registered e-mail address. Make a note of this Auth 

Token. 



Chapter III: Software conception and Simulation 

 Page 43 
 

 

Figure III.6.Blynk app .choosing type of connection. 

 

3. In the project space, select the “+” symbol to add a widget to your project. Since I 

will toggling an LED connected to one of the Digital I/O pins of Arduino, I will 

select a “Button”. 
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Figure III.7.Blynk app Set Button. 

4. Select the Button to change its settings. First, select the LED Pin of Arduino. I 

have used the onboard LED of Arduino UNO. So, select “PIN” and set “Digital” 

and “D13”. Also, the mode of the button can set as “Switch”, for toggle action. 

 

Figure III.8. Blynk app Adjusting the Pin. 

That is it. The Blynk App is set. The next step is installing the libraries. 

 Go to the official GitHub page of Blynk and download the latest release. 

 Download the zip file. Extract the contents of the zip file and copy the 

contents of the “libraries” folder and paste them into the libraries folder of 

Arduino.  

 open Arduino IDE and select File –> Examples –> Blynk –> 

Boards_USB_Serial –> Arduino_Serial_USB sketch. 

 Scroll down to the line that says ‘char auth [] =”YourAuthToken” and add 

the Auth Token you received in mail in place of YourAuthToken.  

 Select the correct COM Port and upload the sketch to Arduino. 

 The final step is run a small script in your laptop / PC. Open Command 

Prompt with Administrator Privileges and change the working directory to 
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“C:\Program Files (x86)\Arduino\libraries\Blynk\scripts” using the cd 

command. 

 

Figure III.9. Window folder. 

 Now we use the .bat file. In the command, enter the following and hit enter. Blynk-ser.bat 

–c COM5 

 

Figure III.10. Command Prompt 

Here, COM5 is the COM Port to with Arduino UNO is connected to in my case.       
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This step allows the Blynk Server to communicate with the device connected to COM5 of 

this PC. Since Arduino is connected in our case, Blynk will be able to control Arduino 

Board. 

Now, we open the Blynk App the Phone and press of the button to see the LED ON and 

OFF according to the status of the Button. [47] 

III.4.3 

       VSPE is intended to help software engineers and developers to create debug test 

applications that use serial ports. It is able to create various virtual devices to transmit or 

receive data. Unlike regular serial ports, virtual devices have special capabilities: for 

example, the same device can be opened more than once by different applications, that 

can be useful in many cases. With VSPE you are able to share physical serial port data for 

several applications, expose serial port to local network (via TCP protocol), and create 

virtual serial port device pairs and so on.[48] 

 

                          Figure III.11.Virtual Serial Ports Emulator (VSPE) 

 

 VSPE help developers to create and debug applications without real hardware 

installed. 

 It helps people to make data stream from any source (like TCP connection, USB 

port and so on) visible to any program via virtual serial port. 

 To create a lot of virtual serial ports working simultaneously. You can do it 

without installing serial ports extension board. 

 To share serial port for many applications. [49] 

VPSE FEATURES

Virtual Serial Ports Emulator (VSPE)
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III.4.4 

      It is possible to use the Arduino without Arduino. The Tinkercad website indeed hosts 

a virtual Arduino.                                                                                                            

 The virtual Arduino is as real as life. It also allows you to experiment, save or share new 

connections. You can even use components that you don't have at home, or safely test 

some questionable connections. to try it, go to this address: 

https://www.tinkercad.com/circuits                                                                           

Click Register (or Login, if you have already registered). 

Follow the registration process to the end. Then, log in and select the Tours section. 

Then click on Create new Circuit or on Edit (available by hovering over an already 

created circuit). 

 
 

Figure III.12. Tinkercad 

 

 

The different commands available:  

Code Editor: edit and upload the code. 

Components: add components (Arduino, breadboard, LED. Resistors 

Start Simulation: feeds the virtual Arduino (and starts the execution of the sketch). 

Export: save the circuit as a file (on the computer). 

 Share: photograph the circuit. 

Then, to save the circuit and return to the general menu, click on the Tinkercad icon.[50] 

Tinkercad
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III.4.5 

It is a programming language, which is inspired by several languages. We find in 

particular similarities with C, C ++, Java. The language imposes a particular structure 

typical of embedded computing. The setup function will contain all the operations 

necessary for the configuration of the board (directions of inputs / outputs, serial 

communications rates, etc). [45] 

 

Figure III.13.The Arduino IDE. 

 
 

 To edit a program: sketches. 

 to compile this program in the Arduino machine language, 

 to upload the program to the memory of the Arduino, 

 Communicate with the Arduino board through the terminal. [51] 

 

 

 

 

 

The Arduino IDE allows

Arduino IDE
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III.5  Simulation 

The simulation which can be used for the purpose of checking the project in software 

design and it produces the correct outcome. [52] 

III.5.1 

The electronic diagram of the Arduino with the sensor lm35 is shown in the following 

figure: 

 

(a)                                                                       (b) 

Figure III.14.Interfacing lm35 with Arduino: (a) in Proteus (b) on the Arduino board. 

III.5.1.1 

 

 

 

 

                    Figure III.15. Flow chart of lm35. 

Start 

Initialization of sensor 

Display 

Read temperature sensor 

Analog to digital converter 

Interfacing lm35 with Arduino
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No 

III.5.2 

 

(a)                                                                    (b) 

Figure III.16.Interfacing PIR sensor with Arduino: (a) Proteus (b) tinkercad. 

III.5.2.1 

 

 

 

 

 

 

 

 

 

 

                              Figure III.17.flow chart of PIR sensor. 
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III.5.3 

 

(a)                                                                    (b) 

Figure III.18.Interfacing MQ-2 sensor with Arduino. (a) Proteus (b) on the Arduino board. 

III.5.3.1 

 

 

 

 

 

 

 

 

                            Figure III.19.flow chart of MQ-2 sensor.                        
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III.5.4 

 

(a)                                                                    (b) 

Figure III.20.Interfacing Relay with Arduino. (a) Proteus (b) on the Arduino board. 

 

III.5.5 

  

(a)                                                                    (b) 

  Figure III.21.Interfacing GSM with Arduino. (a) Proteus (b) on the Arduino board. 

 

 

Interfacing Relay with Arduino (controlling bulb)

Interfacing GSM module with Arduino
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III.5.6 

 

(a)                                                                    (b) 

 Figure III.22.Interfacing LDR with Arduino. (a) Proteus (b) on the Arduino board 

 

III.5.7 

 

(a)                                                                    (b) 

  Figure III.23.Interfacing Buzzer with Arduino. (a) Proteus (b) on the Arduino board. 

 

 

 

 

Interfacing LDR with Arduino

Interfacing Buzzer with Arduino
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III.6 Functionality of the System 

Our system is based on three main modes which are automatic, alarm and the remote 

mode. 

 Automatic mode: the load will be controlling automatic by obtaining both of 

temperature, lighting values from the sensors used and acting according to the 

information collected. 

 

 Alarm mode: if the gas detector mentions a leakage of a gas the alarm 

will activate (the Beep of the Buzzer) than the Arduino will send a Warning 

message to the user by GSM module. 

 

 

 Remote mode: the user can control the load manually (turn on/off) by an android 

app irrespective of the values received from the sensors. 
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III.7  Explanation and Result 

The general aspect of our system is summarized in the following diagram. 

 

Figure III.24. The connection diagram of the system.  

        The Arduino Uno scans the inputs of the sensors (presence, gas, temperature), when 

there is a gas leak, the Arduino will activate the alarm (BUZZER) then transmitted a 

message by GSM module and display Warning message on the LCD, “Alarm mode”     

        When there is a detection of human presence, he’s going to check the temperature 

sensor first if it higher than 30°c he will turn the fan on if not, the fan is off. 

 The light will turn on when there is a detection of human being and the Light Depending 

Resistor (Voltage) is superior to the threshold value. “Automatic mode” 

Plus the load status will be displayed on LCD 

         In this part of the project we tried a command by a mobile application without a 

relay switching. “Remote mode” 
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Figure III.25. A command by a mobile app. 

 

The results that we get after using both of Blynk app and VSPE to control Arduino   

through the simulation (Proteus) is shown in Figure III.26 

 

 

                                                                          (a) 
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                                                                        (b) 

                  Figure III.26. (a). (b) Controlling the load (turn on/off) by Blynk app. 

 

 

 

III.8  Conclusion  

       In chapter three we discuss about different software used, we describe the model of 

home automation system and finally we were shown the results that’s we obtained by 

using android app to control the Home Appliance              .
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         Throughout the preparation of our final project, we wanted to implement the 

knowledge obtained during our university studies in order to develop a system that will 

automatically control the electrical devices in the home in order to save energy. 

       In this project, we tried to implement a system that would respond to the main home 

automation tasks in a simple way.  

The operational design as well as the methods of representing domain information was 

discussed in detail, we have seen the progress made in the home automation domain since 

its creation in the 1980s, up to today. 

We have also outlined various technologies that are used in home automation. We may 

assume home automation is an innovative system that is expected to develop further in the 

future.  

     This system enables you to control an entire house using your Smartphone from a 

touch of a button. Or by another method using simple relay sensors and with the help of 

Arduino. 

      we build a platform capable of controlling appliances with a focus on low cost and 

open source configurability. 

        In the Future home automation will provide almost all the required facilities, such as 

communication, medical, energy, service, entertainment and fitness.  

We may assume that home will be more automated tomorrow as we move on to the next 

generation and technology advancements. 
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